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Introducción
  Símbolos y convenciones

Indica que el incumplimiento de una acción recomendada puede dañar la impresora.

Información que precisa o amplía algunos puntos del texto principal.

 

 Avanzado (Advanced) > Ajustar (Fit) :

Texto en la interfaz de Badge Studio sobre el que puede hacer clic.

Siga la ruta del sitio web de Evolis para acceder a la documentación o a los archivos de instalación del 
controlador de la impresora. 

Funciones solo disponibles en la edición PLUS de Badge Studio.

  Cómo funciona Badge Studio
Un documento en Badge Studio asocia el diseño de las tarjetas con la gestión de datos para una serie 
de tarjetas mediante el área de diseño de las tarjetas y su tabla de datos. El funcionamiento de ambos es 
paralelo: una tarjeta de una serie corresponde siempre a una fila de la tabla de datos, y los elementos 
del diseño de la tarjeta pueden estar vinculados a las columnas de la tabla de datos.

  Diseño de la tarjeta  

  Para comenzar un documento nuevo, seleccione un 
modelo de tarjeta predefinido o un modelo de tarjeta 
virgen.

  A continuación, en el área de diseño de las tarjetas, 
añada, personalice, cambie el tamaño y la posición de 
los elementos (texto, imágenes, códigos de barras y 
formas) que desee que aparezcan en las tarjetas de su 
serie de tarjetas.

Puede decidir qué elementos de texto, imágenes y 
códigos de barras varían de una tarjeta a otra y cuáles 
son idénticos en todas las tarjetas.

  Gestión de datos  

  En la tabla de datos, edite los datos (texto, imágenes, 
datos de códigos de barras) que variarán de una tarjeta 
a otra. Añada filas para añadir tarjetas basadas en el 



Introducción Lo que ofrece la edición PLUS

5

mismo diseño de tarjeta y que contengan los mismos 
elementos que las otras tarjetas.

  Importe los datos de otros documentos con la ayuda de 
un asistente.

  Impresión  

  Para imprimir las tarjetas, seleccione una, varias o todas 
las filas de la tabla de datos antes de configurar e iniciar 
la impresión.

  Lo que ofrece la edición PLUS
Las ediciones STANDARD y PLUS de Badge Studio están disponibles. La edición PLUS incluye funciones 
adicionales con respecto a la edición STANDARD:

Diseñar una tarjeta por ambos lados

Bloquear los elementos de la tarjeta mediante contraseña

Importar datos

Eliminar las filas duplicadas al importar los datos

Bloquear/desbloquear una columna

Imprimir por ambos lados con la ayuda de un asistente

  Por defecto, la solución Badgy 100 incluye la edición STANDARD. La solución Badgy 200 incluye la 
edición PLUS.

Los usuarios de la edición STANDARD pueden beneficiarse de esas funciones adicionales activando una 
licencia para la edición PLUS.

  Interfaz de inicio
La interfaz de inicio se muestra al iniciar Badge Studio o al cerrar un documento.
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Crear documento nuevo

Examinar documentos recientes

 

Abrir el documento

Cambiar nombre del documento

Abrir un documento que no se muestra Archivo (File) > Abrir documento (Open a document)

Cambiar el idioma Archivo (File) > Idiomas (Languages)



Instalación, licencia y versiones Instalar el controlador y el software

7

Instalación, licencia y versiones
Instalar el controlador y el software

Requisitos mínimos

  Sistema operativo: Windows®/macOS (Manual de compatibilidad del software)

RAM: 2 GB

Espacio libre en el disco duro: 1,5 GB

Resolución de pantalla: 1024 x 768 píxeles

Conectividad: 1 puerto USB

Una cámara web integrada compatible con DirectShow, WIA o TWAIN

Instalar el controlador y el software mediante una memoria USB

 
Todas las versiones de Windows exigen que el usuario disponga de los derechos de 
administrador para instalar el driver.

No conecte la impresora hasta que el proceso de instalación haya terminado.

 1. Con la solución se entrega una memoria USB con el controlador y el software.

 2. Abra el contenido de la memoria USB en el explorador de Windows/Finder de macOS.

 3. Abra el archivo Setup.exe (para Windows)/Setup.pkg (para macOS).

Por defecto, esto iniciará la instalación del controlador de la impresora y el software Badge 
Studio.

 

 4. Cuando el proceso de instalación haya terminado, utilice el cable USB para conectar la impresora 
al ordenador.

Instalar el controlador y el software a partir de una descarga

 
Todas las versiones de Windows exigen que el usuario disponga de los derechos de 
administrador para instalar el driver.

No conecte la impresora hasta que el proceso de instalación haya terminado.

 1. Vaya a la página Badge Studio en www.evolis.com > Sección de asistencia > Página del 
producto.

 2. Haga clic en la versión más reciente del archivo .exe (en Windows) /.pkg (en macOS).

 3. Haga clic en Descargar (Download).

https://downloads.evolis.com/evolis/documents/evolis-application-software-compatibilty-chart.pdf
https://es.evolis.com/
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▶  El archivo .exe/.pkg se descarga en su ordenador.

 4. Cuando termine la descarga, abra el archivo Setup.exe/Setup.pkg.

Por defecto, esto iniciará la instalación del controlador de la impresora y el software Badge 
Studio.

 

 5. Siga los pasos de instalación que irán apareciendo en pantalla.

 6. Cuando el proceso de instalación haya terminado, utilice el cable USB para conectar la impresora 
al ordenador.

Desinstalar Badge Studio

  Windows

 1. En el menú Inicio de Windows, vaya a la carpeta BadgeStudio y seleccione 
BadgeStudioUninstall.

 2. Haga clic en Eliminar para desinstalar el software del ordenador.

macOS

 1. Desde Aplicaciones, pongaBadge Studio en la papelera de reciclaje.

 2. Debe eliminar manualmente los archivos de configuración y la lista de documentos.

Gestión de software, licencias y versiones

Activar una licencia

   1. Compre una licencia para la edición PLUS a su distribuidor de Badgy.

 2. Desde Badge Studio, vaya a Archivo (File) > Licencia de Badge Studio.

 3. Introduzca el código de activación que le ha enviado su distribuidor.

Si tiene un código de 64 dígitos, marque la casilla correspondiente.

 4. Haga clic en Activar licencia (Activate License).

Activar una licencia en un ordenador sin conexión

 
Una licencia PLUS se puede activar en un ordenador cada vez.

En el ordenador sin conexión:

 1. Inserte una memoria USB.

 2. Inicie Badge Studio.
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 3. Vaya a Archivo (File)  > Licencia de Badge Studio.

 4. Haga clic en Más opciones de licencia (More licensing options), seleccione Activar / 
desactivar la licencia sin conexión (Activate / Deactivate license offline) y, a continuación, 
haga clic en Activar / desactivar sin conexión (Activate / Deactivate Offline).

 5. Seleccione Activar la licencia en este ordenador (Activate license on this computer) y, a 
continuación, haga clic en Avanzar > (Next >).

 6. Seleccione la ubicación de la memoria USB donde se va a generar y guardar el archivo .txt.

 7. Haga clic en Avanzar > (Next >) pero no cierre el asistente.

 8. Extraiga la memoria USB.

En un ordenador conectado a Internet con Badge Studio instalado:

 1. Inserte la memoria USB.

 2. Inicie Badge Studio.

 3. Vaya a Archivo (File)  > Licencia de Badge Studio.

 4. Haga clic en Más opciones de licencia (More licensing options), seleccione Activar / 
desactivar la licencia sin conexión (Activate / Deactivate license offline) y, a continuación, 
haga clic en Activar / desactivar sin conexión (Activate / Deactivate Offline).

 5. Seleccione Activar la licencia de un ordenador sin conexión (Activate license for an offline 
computer) y, a continuación, haga clic en Avanzar > (Next >).

 6. Seleccione el archivo .txt en la memoria USB.

 7. Introduzca el código de activación que le ha enviado su distribuidor de Badgy.

 8. Haga clic en Activar licencia (Activate License).

 9. Seleccione la ubicación de la memoria USB donde se va a generar y guardar el archivo .license.

 10. Extraiga la memoria USB.

En el ordenador sin conexión:

 1. Inserte la memoria USB.

 2. En el asistente que ha abierto anteriormente, seleccione el archivo .license en la memoria USB

 3. Haga clic en Activar licencia (Activate License).

▶  El asistente activará la licencia PLUS en este ordenador sin conexión.

Desactivar un licencia

  Una licencia activada con un cupón de actualización puede desactivarse en un ordenador conectado a 
Internet.

 1. Inicie Badge Studio.

 2. Vaya a Archivo (File) > Licencia de Badge Studio.

 3. Haga clic en Más opciones de licencia (More licensing options) y seleccione Activar / 
Desactivar la licencia (Activate / deactivate license).

 4. Haga clic en Desactivar la licencia (Deactivate license).

▶  Badge Studio se conecta al servidor de licencias para llevar a cabo la desactivación.
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Desactivar una licencia en un ordenador sin conexión

  Una licencia PLUS se puede activar en un máximo de un ordenador sin conexión, por tanto, es posible 
que necesite desactivar la licencia PLUS de algún ordenador para poder activarla en otro distinto.

En el ordenador sin conexión donde está instalada la licencia que desea 
desactivar

 1. Inserte una memoria USB.

 2. Inicie Badge Studio.

 3. En la interfaz de inicio, haga clic en Archivo (File) > Licencia de Badge Studio.

 4. Haga clic en Más opciones de licencia (More licensing options), seleccione Activar / 
desactivar la licencia sin conexión (Activate / Deactivate license offline) y, a continuación, 
haga clic en Activar / desactivar sin conexión (Activate / Deactivate Offline).

 5. Seleccione Desactivar la licencia en este ordenador (Deactivate license on this computer) y, 
a continuación, haga clic en Avanzar > (Next >).

 6. Seleccione la ubicación de la memoria USB donde se va a generar y guardar el archivo .txt.

 7. Extraiga la memoria USB.

En un ordenador conectado a Internet con Badge Studio instalado:

 1. Inserte una memoria USB.

 2. Inicie Badge Studio.

 3. En la interfaz de inicio, haga clic en Archivo (File)  > Licencia de Badge Studio.

 4. Haga clic en Más opciones de licencia (More licensing options), seleccione Activar / 
desactivar la licencia sin conexión (Activate / Deactivate license offline) y, a continuación, 
haga clic en Activar / desactivar sin conexión (Activate / Deactivate Offline).

 5. Seleccione Desactivar la licencia de un ordenador sin conexión (Deactivate license for an 
offline computer) y, a continuación, haga clic en Avanzar > (Next >).

 6. Seleccione el archivo .txt en la memoria USB.

 7. Haga clic en Desactivar la licencia (Deactivate license).

▶  La licencia quedará desactivada y podrá utilizarla para activar una licencia PLUS en otro 
ordenador sin conexión.

Actualizar el software a la versión más reciente

  DesdeBadge Studio, vaya a Ayuda (Help) > Verificar actualizaciones de software (Check for 
software updates).

 l Si su software está actualizado, aparecerá un mensaje de confirmación:
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 l Si hay una actualización disponible

 a. Haga clic en Descargar (Download).

▶  Se descarga un archivo .exe (Windows)/.pkg (macOS) en su ordenador.

 b. Abra el archivo .exe / .pkg descargado.

 c. Siga los pasos de instalación que irán apareciendo en pantalla.

Desactivar la búsqueda de la última versión

  Por defecto, Badge Studio busca la versión más reciente del software intentando conectarse a un 
servidor remoto.

 1. Desde Badge Studio, vaya a Ayuda (Help) > Verificar actualizaciones de software (Check for 
software updates).

 2. Deje sin marcar la casilla Verificar actualizaciones automáticamente (Automatically check 
for updates).
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Diseño de tarjetas
Área de diseño de tarjetas

  El área de diseño de tarjetas se muestra después de haber seleccionado un modelo de tarjeta o de 
haber abierto un documento existente. Por defecto, solo se muestra el anverso.

  Ampliar/reducir
 

  Aplicar el zoom más adecuado para mostrar la 
tarjeta

Mostrar el reverso

  Reproducir formato
 

  Cancelar las acciones realizadas
 

  Rehacer las acciones canceladas
 

  Guardar el documento actual
 

  Imprimir las tarjetas seleccionadas
 

  Cerrar el documento actual y regresar a la interfaz 
de inicio
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  Seleccionar las unidades de medida utilizadas para 
cambiar el tamaño/colocar los elementos

 Vista (View) > Unidades de medida 
(Measurement System)

  Mostrar/ocultar la cuadrícula que sirve para 
cambiar el tamaño/colocar los elementos 
visualmente

 Vista (View) > Mostrar cuadrícula (Show Grid)

  Mostrar/ocultar las líneas que se cruzan en el centro 
de la tarjeta y que sirven para colocar los elementos 
visualmente

 Vista (View) > Referencias (Guide Lines)

  Mostrar/ocultar las reglas que indican la posición 
horizontal y vertical de los elementos

 Vista (View) > Mostrar reglas (Show Rulers)

  Activar/desactivar la alineación de los elementos en 
la cuadrícula

 Vista (View) > Ajustar (Snap) > Ajustar a la 
cuadrícula (Snap To Grid)

  Mostrar/ocultar la alineación de unos elementos 
con los demás

 Vista (View) > Ajustar (Snap) > Ajustar a los 
objetos (Snap To Objects)

  Indicar el área que queda oculta por el soporte de 
la etiqueta

 Vista (View) > Mostrar huella del soporte de 
etiqueta (Show tag holder footprint on card)

  Elementos alineados

líneas azules delgadas en la extensión del elemento

  Hacer girar un elemento visualmente

 

líneas rojas discontinuas cuando el elemento se 
gira 90°/180°/270°

   

Fondo seleccionado

línea de puntos roja alrededor del borde de la 
tarjeta

Seleccione el modelo de tarjeta

Seleccionar un modelo de tarjeta predefinido

   1. En la interfaz de inicio, haga clic en:

 

▶  Un asistente mostrará una serie de modelos de tarjeta.



Diseño de tarjetas Seleccione el modelo de tarjeta

14

 2. Haga clic en el tipo de aplicación al que se van a dedicar las tarjetas:

 

 3. Para ver una selección más precisa de los modelos de tarjeta, utilice las listas desplegables y las 
casillas de verificación:

 

 

 4. Para ver los detalles de los elementos en la tarjeta, pase el ratón por encima de ella y haga clic en 

el icono de información: 

 5. Seleccione un modelo de tarjeta y haga clic en Crear (Create).

▶  El área de diseño de tarjetas se abrirá y le permitirá añadir y personalizar los elementos de la 
tarjeta.

Seleccione un modelo de tarjeta virgen

   1. En la interfaz de inicio, haga clic en:

 

▶  Un asistente mostrará una serie de modelos de tarjeta.

 2. Haga clic en

 

▶  Se mostrará una serie de modelos de tarjetas vírgenes:

 3. Para ver una selección más precisa de los modelos de tarjeta, utilice los filtros:

 

 4. Seleccione un modelo de tarjeta y haga clic en Crear (Create).
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▶  El área de diseño de tarjetas se abrirá y le permitirá añadir y personalizar los elementos de la 
tarjeta.

Personalizar el fondo de la tarjeta

  Seleccionar un fondo de tarjeta predefinido

 1. En el lado de la tarjeta al que le va a aplicar el fondo, haga clic en un área vacía separada de los 
elementos.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Fondo (Background), haga clic en uno de los fondos predefinidos.

 a. Aplicar al anverso: haga clic en el icono de tarjeta de la izquierda

 

 b. Aplicar al reverso: haga clic en el icono de la tarjeta de la derecha:

 

   

Seleccione una imagen como fondo de la tarjeta

 1. En el lado de la tarjeta al que le va a aplicar el fondo, haga clic en un área vacía separada de los 
elementos.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Fondo (Background), haga clic en el icono de directorio:

 3. Seleccione uno de sus archivos de imagen.

Dar formato al fondo de la tarjeta

En el lado de la tarjeta donde se va a modificar el fondo, haga clic en un área vacía separada de los 
elementos.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

    Propiedades de imagen (Image properties)

Colores de la imagen original

Escalas de grises
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  Monocromo

  Negativo

 
Si va a imprimir con una cinta monocroma (una cinta de un solo color), las imágenes deben 
tener un formato monocromo (pero además pueden tener un formato negativo).

  Saturación/brillo/contraste

 

  Restablecer la configuración original
  

  Eliminar un color del fondo de la tarjeta

 1. En el lado de la tarjeta donde se va a modificar el fondo, haga clic en un área vacía separada de 
los elementos.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Propiedades de imagen (Image properties) > Eliminar el fondo (Remove background), 
haga clic en la pequeña flecha situada a la derecha del icono de persona:

 

 3. Haga clic en Cuentagotas (Color Picker).

▶  El cursor se transformará en un cuentagotas.

 4. Haga clic en una muestra del color que desea eliminar.

 5. En Tolerancia (Tolerance), deslice el cursor hacia la izquierda o la derecha para ajustar el umbral 
a partir del cual se eliminará el color.

 6. Para restablecer el valor original haga clic en:

  

Recortar la imagen de fondo de la tarjeta

 1. En el lado con la imagen de fondo que desea recortar, haga clic en un área vacía separada de los 
elementos.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. Haga clic en: 

 

 3. Arrastre los cuadrados rojos para delimitar la zona deseada de la imagen:
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 4. Haga clic en Truncar (Crop).

Eliminar el fondo de la tarjeta

 1. En el lado de la tarjeta donde se va a modificar el fondo, haga clic en un área vacía separada de 
los elementos.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. Haga clic en la pequeña flecha situada a la derecha del icono de orientación horizontal con una 
equis:

 

En la lista desplegable, haga clic en el lado cuyo fondo desea eliminar:

 

Añadir/personalizar texto

  Añadir texto

Para añadir texto totalmente nuevo

Haga clic en el icono de texto:

 

Para añadir texto a partir de una columna existente

En la tabla de datos, arrastre y coloque el encabezado de la columna en la tarjeta.

▶  Un elemento de texto variable, vinculado con la columna correspondiente de la tabla de datos, 
aparecerá en la tarjeta y le permitirá editarlo.

Posteriormente, puede transformar el texto en fijo.
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Editar el texto

 1. Si no está seleccionado aún en la tarjeta, haga clic en el elemento de texto.

 2. Introduzca el texto deseado.

 3. Pulse la tecla Intro.

Si el texto está vinculado a una columna de la tabla de datos, el texto de la fila correspondiente a la 
tarjeta se modificará también.

Dar formato al texto

Haga clic en el elemento de texto.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

    Fuente (Font)

  Color de texto
 

  En negrita/cursiva/subrayado/tachado
 

  Caja (por ejemplo, minúsculas)
 

  Aumentar/reducir el tamaño de los caracteres

 

  Fuente

  Tamaño de los caracteres

  Tamaño de los caracteres ajustado 
automáticamente para adaptar el texto a las 
dimensiones del elemento, respetando los límites 
máximo o mínimo

Además de Avanzado (Advanced) > Talla de la 
fuente (Font Size)  > Tamaños de fuente 
mínimo y máximo (Minimum and maximum 
sizes)

     

  Posicionamiento Párrafo (Paragraph)

  Posición vertical dentro del elemento

 

  Justificación

 

  Salto de línea (para forzar que el texto comience en 
una línea nueva, si fuera necesario)  
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  Elemento  

  Color de fondo/del marco

  

  Reproducir un formato de texto

 1. Haga clic en el elemento de texto cuyo formato desea reproducir.

El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. Haga clic en el icono de reproducción de formato:

 

 3. Haga clic en el elemento de texto al que desea aplicar el formato.

Transformar el texto en fijo

Los elementos que son fijos son idénticos en todas las tarjetas del documento y aparecerán en todas 
ellas.

 1. Haga clic con el botón derecho en el elemento y seleccione Transformar en 
texto/imagen/código de barras variable.

▶  Se abre una ventana para confirmar la transformación.

 2. Haga clic en Aceptar (OK) para confirmar.

▶  La columna vinculada se eliminará de la tabla de datos.

Los datos de esta columna no se podrán recuperar.

 

Añadir/personalizar una imagen

  Añadir una imagen

Si imprime con una cinta monocroma (una cinta de un solo color), las imágenes con una 
gama de grises/colores no son adecuadas.

Para añadir una imagen nueva a partir de sus archivos personales

Haga clic en el icono de orientación horizontal.  
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Añadir una nueva imagen desde la cámara web

El ordenador debe estar equipado con una cámara web.

 

 1. Haga clic en el icono Hacer una foto de la cámara.

 2. A continuación, haga clic en el icono de Cámara web para hacer la foto.

 3. Haga clic en Aquire para añadir la foto en el diseño de la tarjeta.

Para añadir una imagen a partir de una columna existente

En la tabla de datos, arrastre y coloque el encabezado de la columna en la tarjeta.

▶  La imagen variable, vinculada con la columna correspondiente de la tabla de datos, aparecerá en la 
tarjeta y le permitirá darle formato, cambiar su tamaño y su posición.

Posteriormente, puede transformar la imagen en fija.

Dar formato a una imagen

Haga clic en la imagen.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

    Formato (Format)

  Color de fondo/del marco  

 

    Propiedades de imagen (Image properties)

Colores de la imagen original

Escalas de grises

  Monocromo



Diseño de tarjetas Añadir/personalizar una imagen

21

  Negativo

 
Si va a imprimir con una cinta monocroma (una cinta de un solo color), las imágenes deben 
tener un formato monocromo (pero además pueden tener un formato negativo).

  Saturación/brillo/contraste

 

  Restablecer la configuración original
  

  Eliminar un color de una imagen

 1. Haga clic en la imagen.

El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Propiedades de imagen (Image properties) > Eliminar el fondo (Remove background), 
haga clic en la pequeña flecha situada a la derecha del icono de persona:

 

 3. Haga clic en Cuentagotas (Color Picker).

El cursor se transformará en un cuentagotas.

 4. Haga clic en una muestra del color que desea eliminar.

 5. En Tolerancia (Tolerance), deslice el cursor hacia la izquierda o la derecha para ajustar el umbral 
a partir del cual se eliminará el color.

 6. Para restablecer el valor original haga clic en:

  

Cambiar una imagen

 1. En la tarjeta, haga doble clic en la imagen.

 2. Seleccione un archivo de imagen.

▶  Si la imagen está vinculada con una columna de la tabla de datos, la imagen de la fila 
correspondiente a la tarjeta se modificará también.

Transformar una imagen en fija

Los elementos que son fijos son idénticos en todas las tarjetas del documento y aparecerán en todas 
ellas.

 1. Haga clic con el botón derecho en el elemento y seleccione Transformar en 
texto/imagen/código de barras variable.
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▶  Se abre una ventana para confirmar la transformación.

 2. Haga clic en Aceptar (OK) para confirmar.

▶  La columna vinculada se eliminará de la tabla de datos.

Los datos de esta columna no se podrán recuperar.

 

Añadir/personalizar un logotipo

  Añadir logotipo

Por defecto, un logotipo es una imagen fija sobre el fondo de la tarjeta. Los elementos que son fijos son 
idénticos en todas las tarjetas del documento y aparecerán en todas ellas.

 1. Haga clic en el icono Añadir logotipo (Add Logo).

▶  Se añade una nueva zona de imagen en el centro de la tarjeta y se abre el explorador del 
sistema operativo.

 2. Seleccione la imagen que desea utilizar como logotipo.

 3. Haga clic en Abrir (Open) para añadir el logotipo al diseño de tarjeta.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.. 

El tamaño y la ubicación del logotipo pueden modificarse.

Cambiar un logotipo

 1. En la tarjeta, haga doble clic en la imagen.

 2. Seleccione un archivo de imagen.

▶  Si la imagen está vinculada con una columna de la tabla de datos, la imagen de la fila 
correspondiente a la tarjeta se modificará también.

Modificar la fuente de la imagen de un logotipo

Se puede cambiar la fuente de la imagen de un logotipo. La fuente puede ser el disco duro (desde una 
carpeta del ordenador o un servidor) o la cámara web del ordenador.

 1. En el área de diseño de tarjeta, haga clic en el logotipo.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Avanzado (Advanced), haga clic en Fuente imagen (Image source).

 3. Seleccione una fuente de la lista desplegable.
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 4. Una vez que haya modificado la fuente del logotipo, puede hacer clic en el icono del directorio.
 l Cuando la fuente seleccionada es Del disco (From disk), se abre el explorador del 

ordenador.
 l Cuando la fuente seleccionada es Cámara web intergrada, se abre una ventana de 

captura de imágenes.

 1. Haga clic en el icono de Cámara web para hacer la foto.

 2. Haga clic en Aquire para añadir la foto en el diseño de la tarjeta.

Añadir/personalizar un código de barras

  Añadir un código de barras

Para añadir un código de barras en 1D totalmente nuevo

Haga clic en el icono de código de barras y luego en el icono de código de barras en 1D:

  >  

Para añadir un código de barras en 2D totalmente nuevo

Haga clic en el icono de código de barras y luego en el icono de código de barras en 2D:

  >   

Para añadir un código de barras en 1D a partir de una columna existente

En la tabla de datos, arrastre y coloque el encabezado de la columna en la tarjeta.

▶  Un código de barras, vinculado con la columna correspondiente de la tabla de datos, aparecerá en la 
tarjeta y le permitirá editarlo.

Posteriormente, puede transformar el código de barras en fijo.

Editar un código de barras

 1. Si no está seleccionado aún en la tarjeta, haga clic en el código de barras.

 2. Introduzca los datos que desee codificar.

 3. Pulse la tecla Intro.

▶  Si el código de barras está vinculado con una columna de la tabla de datos, los datos de la fila 
correspondiente a la tarjeta se modificarán también.
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Dar formato a un código de barras en 1D

Después de darle formato a un código de barras en 1D, considere imprimir una tarjeta de 
prueba para verificar la legibilidad del código de barras antes de imprimir un volumen 
mayor.

Haga clic en el código de barras.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

  Codificación  

    Código de barras (Barcode)

  Normas de codificación   

     

  Optimización de la legibilidad Avanzado (Advanced) > Código de barras 
(Barcode) > Optimizar (Optimize)

  Cifra adicional utilizada para verificar el resto de los 
datos leídos

Avanzado (Advanced) > Código de barras 
(Barcode) > Dígito de control (CheckDigit)

     

  Dimensiones/disposición

  Anchura de las barras verticales Avanzado (Advanced) > Código de barras 
(Barcode) > Anchura del módulo (Module 
width)

  Relación entre las barras verticales Avanzado (Advanced) > Código de barras 
(Barcode) > Representación (Rendering)

  Espacio vacío a cada lado de las barras verticales Avanzado (Advanced) > Código de barras 
(Barcode) > Zona de silencio (Quiet Zone)

  Barra(s) que enmarcan las barras verticales Avanzado (Advanced) > Código de barras 
(Barcode) > Barra portadora (Bearer bar)

  Anchura de la(s) barra(s) que enmarca(n) las barras 
verticales 

Avanzado (Advanced) > Código de barras 
(Barcode) > Anchura de la barra portadora 
(Bearer width)

     

  Caracteres visibles

  Mostrar los datos codificados en forma de 
caracteres visibles en la tarjeta

Código de barras (Barcode) > Legible por 
humanos (Human readable)

    Fuente (Font)
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  Fuente

  Color de los caracteres
 

  Tamaño de los caracteres

  Anchura total de los caracteres ajustada 
automáticamente para adaptarse a la anchura del 
código de barras

Avanzado (Advanced) > Código de barras 
(Barcode) > Ajustar el texto al código de barras 
(Fit Text to Barcode)

     

  Color

    Fuente (Font)

  Color del código de barras y de los caracteres
 

    Formato (Format)

  Color del fondo
 

  Color del marco
 

  Dar formato a un código de barras en 2D

Después de darle formato a un código de barras en 2D, considere imprimir una tarjeta de 
prueba para verificar la legibilidad del código de barras antes de imprimir un volumen 
mayor.

Haga clic en el código de barras.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

  Codificación

    Código de barras (Barcode)

  Juego de caracteres que puede codificarse Avanzado (Advanced) > Código de barras 
(Barcode) > Página de código (Code Page)

  Formato de codificación de código QR Avanzado (Advanced) > Código de barras 
(Barcode) > Formato del código QR (QRCode 
Format)

  Formato de codificación de Datamatrix Avanzado (Advanced) > Código de barras 
(Barcode) > Código Datamatrix (Datamatrix 
Code)
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  Modo de codificación PDF417 Avanzado (Advanced) > Código de barras 
(Barcode) > Codificación PDF417 (PDF417 
Encoding)

  Modo de codificación Maxicode Avanzado (Advanced) > Código de barras 
(Barcode) > Modo Maxicode (Maxicode Mode)

  Opciones para adjuntar varios códigos de barras 
Maxicode

Avanzado (Advanced) > Código de barras 
(Barcode) > Añadir # (Append #)

  Formato de codificación de AZTEC Rune Avanzado (Advanced) > Código de barras 
(Barcode) > Modo AZTEC (AZTEC Mode)

     

  Optimización de la legibilidad Avanzado (Advanced) > Código de barras 
(Barcode) > Optimizar (Optimize)

  Ajuste de organización de la tabla Avanzado (Advanced) > Código de barras 
(Barcode) > Máscara (Mask)

  Redundancia para garantizar la legibilidad si una 
parte del código de barras está manchado o 
dañado

Avanzado (Advanced) > Código de barras 
(Barcode) > Nivel EC (EC Level)

     

  Dimensiones/disposición

  Número de cuadros que forman la tabla Avanzado (Advanced) > Código de barras 
(Barcode) > Tamaño (Size)  > Tamaño/Versión 
(Size/Version)

  Tamaño de los cuadros que forman la tabla Avanzado (Advanced) > Código de barras 
(Barcode) > Anchura del módulo (Module 
width)

  Altura de las filas de la tabla Avanzado (Advanced)  > Código de barras 
(Barcode)  > Altura de fila (Row height)

  Anchura de las columnas de la tabla Avanzado (Advanced) > Código de barras 
(Barcode) > Anchura de columna (Column 
width)

  Segmentos de datos por fila Avanzado (Advanced) > Código de barras 
(Barcode) > Segmentos de datos (Data 
Segments)

  Relación entre filas y columnas Avanzado (Advanced) > Código de barras 
(Barcode) > Relación R/C (R/C Ratio)

  Espacio vacío alrededor de la tabla Avanzado (Advanced) > Código de barras 
(Barcode) > Zona de silencio (Quiet Zone)
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  Color

    Fuente (Font)

  Color de los cuadros que forman la tabla
 

    Formato (Format)

  Color del fondo
 

  Color del marco
 

  Transformar un código de barras en fijo

Los elementos que son fijos son idénticos en todas las tarjetas del documento y aparecerán en todas 
ellas.

 1. Haga clic con el botón derecho en el elemento y seleccione Transformar en 
texto/imagen/código de barras variable.

▶  Se abre una ventana para confirmar la transformación.

 2. Haga clic en Aceptar (OK) para confirmar.

▶  La columna vinculada se eliminará de la tabla de datos.

Los datos de esta columna no se podrán recuperar.

 

 

Añadir/dar formato a una forma

  Añadir una forma

 1. Haga clic en el icono de forma:

 

 2. A continuación, seleccione una forma del menú:
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▶  La forma se incluirá en la tarjeta y podrá darle formato, cambiar su tamaño y su posición:

Dar formato a una forma

Hacer clic en la forma

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

    Formato (Format)

  Color de fondo
 

  Color del marco
 

Opacidad  Avanzado (Advanced) > Elemento (Item) > 
Opacidad (Opacity)

Añadir/Personalizar vCard

vCard le permite codificar la información que aparece en una tarjeta de visita en un código QR. Al 
escanear el código QR con una aplicación lectora de códigos QR, una persona puede crear un nuevo 
contacto en su teléfono, localizar la empresa en una aplicación de mapas, llamar al número de 
teléfono registrado, enviar un correo electrónico a la dirección de correo electrónico registrada, copiar 
o compartir la información.

Dependiendo de la marca del teléfono utilizado para escanear la vCard, pueden 
observarse los siguientes comportamientos al añadir la información a un nuevo contacto:

 l Los campos relacionados con la dirección (campos 9 a 13) pueden reunirse todos 
en un campo de contacto.

 l Los campos relacionados con el empleo (campos 4 a 6) pueden reunirse todos en 
un campo de contacto.
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Garantizar la buena legibilidad del código QR de la vCard
 l El primer plano (el color por defecto es el negro) debe ser de un color más oscuro que el fondo 

(el color por defecto es el blanco).
 l La combinación de primer plano amarillo y fondo blanco hace que el código QR sea ilegible.
 l Asegúrese de que exista un buen contraste entre el primer plano y el fondo del código QR
 l El tamaño mínimo para una buena legibilidad es de 2x2 cm.
 l Añada un contorno del mismo color que el fondo del código QR de al menos 1/4 pt.

Añadir una vCard

Haga clic en el icono de vCard.

▶  En el diseño de la tarjeta aparece un código QR. El código QR de la vCard se muestra para cada fila 
de la base de datos.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

Registrar información

Modo vCard clásica

 1. Si no está ya seleccionado en la tarjeta, pulse el código QR de la vCard.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En la sección Campos vCard (vCard Fields):
 l Puede vincular cada campo a una columna existente de la tabla de la base de datos.

 a. Haga clic en la flecha situada junto a un campo Elija la columna... (Choose 
Column).

 b. Seleccione una columna de su tabla de base de datos.
 l Puede introducir manualmente la información directamente en el campo.

La información tecleada se muestra para todas las filas de la base de datos.
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▶  A continuación se muestra la información registrada de la fila seleccionada:

Foto de contacto solo está disponible cuando está activada la opción de 
modo vCard dinámica.

Modo vCard dinámica

Con el modo vCard clásica, la información se almacena en el propio código QR. Cuantos más campos 
vCard se registren, más denso será el código QR , lo que puede hacerlo ilegible en función de su 
tamaño.

5 campos vCard registrados 15 campos vCard registrados

Con el modo vCard dinámica, el código QR solo almacena una URL y no cambia cuando se registran 
nuevos campos. Toda la información se almacena en un servidor público de Badgy. Eso hace que el 
código QR sea menos denso. Cuando se escanea el código QR, la información de contacto se descarga 
en el teléfono a través de la URL.

El ordenador debe estar conectado a Internet para utilizar el modo vCard dinámica.

Al escanear el código QR de la vCard, el teléfono debe estar conectado a Internet (datos 
móviles o Wi-Fi).

Cuando esté activo el modo de vCard dinámica, guarde siempre el documento después 
de realizar cualquier modificación en un código QR de vCard. Hasta que se guarda el 
documento, el código QR es ilegible y la información no se guarda/actualiza en el 
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servidor.

Para activar el modo de vCard dinámica:

Cuando utilice el modo de vCard dinámica:
 l La eliminación de una fila de la tabla de la base de datos hace que la información 

vinculada a esa fila deje de estar disponible. Escanear el código QR de la vCard en 
una tarjeta previamente impresa ya no dará acceso a la información de contacto.

 l Al eliminar un código QR de vCard del diseño de la tarjeta, la información vinculada 
al código QR deja de estar disponible. El escaneado de tarjetas previamente 
impresas ya no dará acceso a la información de contacto.

 l Trabajar en dos copias del mismo documento Badge Studio (copiadas desde el 
Explorador de Windows/Finder de macOS) dará lugar a incoherencias si se han 
añadido, modificado o eliminado filas en un documento pero no en el otro.

 l Al guardar como... el documento, las dos versiones de los documentos tienen un 
código QR de vCard diferente. Ambas versiones del documento pueden utilizarse 
sin incoherencias.

 1. Si no está ya seleccionado en la tarjeta, haga clic en el código de barras de la vCard.

 2. En Campos vCard (vCard Fields), marque la casilla Activar el modo vCard dinámica 
(Activate dynamic vCard mode).

 3. Aparecerá una ventana emergente para informarle de que se crearán nuevos códigos QR de 
vCard para cada fila de la tabla de la base de datos y que todas las tarjetas tendrán que 
imprimirse de nuevo.

 4. Haga clic en Sí para activar la opción.

 5. Haga clic en el icono de Guardar (Save).

Modificar información de vCard

 1. Si no está ya seleccionado, seleccione el código QR de la vCard en el diseño de la tarjeta. 

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. Haga clic en Borrar contenido (Delete content) para vaciar todos los campos y registrar 
nueva información.

O

 3. Modifique la información directamente en la base de datos.

▶  La información se actualiza en el diseño de la tarjeta y en la visualización del campo vCard.

 4. Haga clic en el icono de Guardar (Save).
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Formatear un código QR de vCard

Si no está ya seleccionado, seleccione el código QR de la vCard en el diseño de la tarjeta.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

    Formato (Format)

  Color de código QR

  Color de fondo

  Color de contorno

  Reproducir formato

    Formato (Format) > Patrón (Pattern)

  Modificar la forma del patrón del código QR de 
vCard 

    Formato (Format) > Organizar (Arrange)

  Alinear exactamente el código QR

  Girar exactamente el código QR

  Mover el código QR hacia delante/atrás
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  Personalizar un código QR de vCard

Los códigos QR de vCard pueden personalizarse añadiendo una imagen (como el logotipo de su 
empresa) al código QR.

Logotipo en el centro del código QR de la vCard

Añadir un logotipo en el centro de un código QR de vCard

 1. Si no está ya seleccionado, seleccione el código QR de la vCard en el diseño de la tarjeta. 

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Logotipo (Logo), haga clic en el icono del directorio y seleccione la imagen que desea añadir.

 3. El logotipo se añade en el centro del código QR de la vCard con un fondo blanco cuando es 
necesario.

Modificar el tamaño de un logotipo en un código QR de vCard

 1. Si no está ya seleccionado, seleccione el código QR de la vCard en el diseño de la tarjeta. 

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. Utilice el calibrador para ajustar el tamaño del logotipo.

Pequeño: el logotipo ocupa el 5 % del código QR.

Mediano: el logotipo ocupa el 8 % del código QR (ajuste por defecto).

Grande: el logotipo ocupa el 11 % del código QR.

Eliminar un logotipo de un código QR de vCard

 1. Si no está ya seleccionado, seleccione el código QR de la vCard en el diseño de la tarjeta. 

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Logotipo (Logo), haga clic en el icono de restauración situado junto a Examinar archivo 
(Browse file):
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▶  El logotipo se elimina del código QR de la vCard y de la vista previa del logotipo seleccionado.

Cambiar tamaño/colocar los elementos

Recortar una imagen

  Haga clic en la imagen.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

Para rellenar completamente el marco existente

En Avanzado (Advanced) > Ajustar (Fit), haga clic en Truncar en la zona (Crop to Fit).

Para mostrar toda la imagen en su marco actual

En Avanzado (Advanced) > Ajustar (Fit), haga clic en Reducirse a la zona (Shrink to fit).

Para recortar un área específica de la imagen

 1. En Formato (Format), haga clic en el icono Recortar.

 

 2. Arrastre los cuadrados rojos para delimitar la zona deseada de la imagen:

 

 3. Haga clic en Truncar (Crop).

Para recortar una imagen según una forma determinada

 1. En Formato (Format), haga clic en la pequeña flecha situada a la derecha del icono con dos 
formas que se cruzan:

 

 2. A continuación, seleccione una de las formas de la lista:
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▶  Algunas partes de la imagen quedarán ocultas al adaptar la imagen a la forma seleccionada:

Mover un elemento al otro lado de la tarjeta

 1. Si el reverso de la tarjeta no se muestra, haga clic en 

 2. Haga clic en el elemento, colocando el cursor sobre el marco para que aparezca la flecha de 
cuatro puntas.

 3. Haga clic en el elemento, arrástrelo hacia el otro lado de la tarjeta y colóquelo ahí.

Avanzar o retroceder un elemento

  En el mismo espacio, las partes de los elementos que ocupan el primer plano ocultarán las partes de los 
elementos que ocupan el plano de fondo. Los elementos de la tarjeta ocupan cada uno un plano que 
determina su visibilidad con respecto a los demás.

Para primer plano

Haga clic derecho en un elemento y luego haga clic en Traer adelante (Bring forward) o Traer al 
frente (Bring to front).

Para plano de fondo

Haga clic derecho en un elemento y luego haga clic en Enviar atrás (Send backward) o Enviar al 
fondo (Send to back).

Cambiar el tamaño de un elemento para rellenar la tarjeta pro-
porcionalmente

  Haga clic derecho en un elemento y luego haga clic en Ajustar a la tarjeta (Fit to Card).
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Ajustar/distribuir los elementos

   1. Mantenga pulsada la tecla Ctrl (Windows)/cmd (macOS) y haga clic en los elementos que desea 
ajustar/distribuir.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Formato (Format) > Organizar (Arrange), haga clic en el icono de alineación y seleccione 
una opción:

  

  

Hacer girar un elemento con precisión

   1. Haga clic en el elemento que desea hacer girar.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Formato (Format) > Organizar (Arrange), haga clic en la pequeña flecha situada a la 
derecha del icono de rotación y elija una de las opciones predefinidas o introduzca el ángulo de 
rotación en el campo:

 

 

Cambiar tamaño/colocar un elemento con precisión

   1. Haga clic en el elemento que desee cambiar de tamaño/colocar.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.



Diseño de tarjetas Bloquear/ocultar los elementos

37

 2. En Avanzado (Advanced), haga clic en Tamaño (Size) > Posición (Position).

 3. Introduzca el ancho/alto/posición en el campo:

 

Bloquear/ocultar los elementos

Bloquear/desbloquear un elemento de la tarjeta

   1. Haga clic en el elemento.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Avanzado (Advanced) > Elemento (Item), marque/desmarque Proteger elemento (Lock 
item).

Bloquear todos los elementos sin contraseña

  En el área de diseño de tarjetas, haga clic en el icono del candado (y no en la pequeña flecha de la 

derecha): 

▶  Los datos de la tabla de datos vinculados a los elementos de la tarjeta no se bloquearán.

Las tarjetas se podrán imprimir siempre.

Bloquear los elementos de la tarjeta mediante contraseña

 1. Haga clic en la pequeña flecha situada a la derecha del icono del candado,

 

A continuación haga clic en Proteger el modelo con una contraseña (Lock design with 
password) > .

 2. Introduzca y confirme la contraseña que desee:
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Si olvida la contraseña, no podrá restablecerla.

 

 3. Haga clic en Aceptar (OK).

Los datos de la tabla de datos vinculados a los elementos de la tarjeta no se 
bloquearán.

Las tarjetas se podrán imprimir siempre.

Desbloquear los elementos de la tarjeta

   1. En el área de diseño de tarjetas, haga clic en el icono del candado (y no en la pequeña flecha de 
la derecha):

 

 2. Introduzca la contraseña definida anteriormente.

 3. Haga clic en Aceptar (OK).

 
Esta acción no desbloquea las columnas bloqueadas vinculadas a los elementos de la 
tarjeta.

Desactivar la protección con contraseña

 1. En el área de diseño de tarjetas, haga clic en la pequeña flecha situada a la derecha del icono del 
candado

 

A continuación haga clic en Desactivar protección con contraseña (Disable password 
protection) 

 2. Introduzca la contraseña definida anteriormente.

 3. Haga clic en Aceptar (OK).

Ocultar/mostrar elementos de la tarjeta

  En el encabezado de la columna vinculada al elemento, haga clic en el icono del ojo.

 / .

Un elemento oculto no se imprimirá.
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Copiar/eliminar elementos

Copiar y pegar un elemento

   1. Haga clic derecho en un elemento y luego haga clic en Copiar (Copy).

 2. Haga clic derecho en el lado y en el área donde desea añadir la copia, luego haga clic en Pegar 
(Paste).

▶  Si es variable, el elemento duplicado se vinculará a una columna nueva de la tabla de datos.

Duplicar un elemento

  Haga clic derecho en un elemento y luego haga clic en Duplicado (Duplicate).

Si es variable, el elemento original y los elementos duplicados se vincularán a la misma 
columna de la tabla de datos, y se actualizarán conjuntamente si se modifica cualquiera de 
ellos.

Eliminar un elemento

  Haga clic derecho en un elemento y luego haga clic en Eliminar (Delete).

Toda columna vinculada no se eliminará de la tabla de datos.
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Gestión de datos
Tabla de datos

 La tabla de datos de debajo del área de diseño de tarjetas contiene los datos que se pueden mostrar en las 
tarjetas. Se organiza en columnas* (cada una agrupa datos de un tipo determinado) y filas* (cada una 
corresponde a un tarjeta).

 

 Añadir una fila
  

 Navegar por las filas (y mostrar las tarjetas 
correspondientes)   

 Buscar datos  

 Seleccione una, varias o todas las filas

 

 Eliminar la fila o filas seleccionadas
  

Añadir una fila

  En el pie de la tabla de datos, haga clic en el icono de signo más:

  

▶  Una file basada en el mismo diseño de tarjeta y con los mismos elementos que las otras tarjetas se 
añadirá a su documento.

Puede cambiar los datos directamente en las celdas de esta fila.

Añadir columna

   1. Haga clic derecho en cualquiera de los encabezados de columna.

 2. Haga clic en Añadir columna (Add column) y seleccione el tipo de columna que desea añadir 
(Añadir columna de código de barras (Add barcode column) / Añadir columna de imagen 
(Add image column) / Añadir columna de texto (Add text column)).

Puede añadir posteriormente elementos vinculados a la tarjeta (texto, imagen, código de barras).
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Añadir/importar datos

Preparar una base de datos externa

  Preparar una base de datos de hojas de cálculo

Deben respetarse las siguientes normas:
 l Los datos que pueden importarse son objetos disponibles en el software (cuadros de texto, 

imágenes, información de códigos de barras, logotipos, etc.).
 l Rellene la hoja de cálculo del siguiente modo: nombres de las columnas en la primera fila de la 

hoja de cálculo y valores que se mostrarán en las filas siguientes.
 l Evite incluir celdas fusionadas. No se pueden importar al software.
 l Para incluir imágenes en una base de datos de hojas de cálculo, utilice la función Enlace.

Preparar una base de datos de archivos .txt.

Deben respetarse las siguientes normas:
 l la primera fila debe utilizarse como ejemplo para todo el archivo .txt. Esta fila corresponde a los 

títulos de las columnas de la base de datos. (1)
 l Siga siempre el ejemplo de la primera fila para rellenar el archivo .txt.
 l Para añadir imágenes, utilice la ruta completa y el nombre de la imagen (con la extensión del 

archivo).
 l Si las filas deben importarse en un orden determinado, añada un número como primera entrada. 

Añada un nombre de columna a los números de fila para que no se importen como entradas. (2)
 l Separe cada elemento con un delimitador: coma (,) o punto y coma (;). (3)

Si no se detecta ningún delimitador, la importación no se realizará correctamente.
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Importar datos

Importar datos de un documento de Excel/CSV/.txt

Seleccionar el archivo que importar

 1. Abra el documento Badge Studio al que desea importar los datos.

 2. Haga clic en Archivo (File) > Importar datos (Import data).

▶  Se abre la ventana de importación.

 3. Haga clic en la pestaña Importación (Import) > Importar desde Excel / CSV / TXT (Import 
from EXCEL / CSV / TXT)

 4. Haga clic en Examinar archivo (Browse file) y, a continuación, seleccione el documento que 
contiene los datos que desea importar.

Para indicar los datos de un documento de Excel que desea importar:

 1. Marque Opciones avanzadas (Advanced options).

 2. Seleccione la hoja en la lista desplegable o indique el rango de celdas que contienen 
los datos:

Para sincronizar los datos con un documento de Excel:

 1. Marque Opciones avanzadas (Advanced options).

 2. Marque Actualización automática de los datos (Auto Import Data).

 3. Seleccione una de las opciones disponibles.

 5. Haga clic en Avanzar > (Next >).

  Vincular elementos del diseño de la tarjeta a una columna del archivo

▶  El cuadro de diálogo mostrará los elementos en el diseño de su tarjeta a la izquierda, y las columnas 
del documento importado a la derecha:

 1. Haga clic en Mostrar otras columnas en la tabla (Show more columns from my table) para 
mostrar las columnas de la tabla de datos no vinculadas a los elementos de la tarjeta.

▶  Las columnas se mostrarán debajo de la tarjeta:
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 2. Haga clic en el elemento (o columna) de la izquierda y, a continuación, en la columna 
correspondiente de la derecha para cada elemento (o columna no vinculada) que desee vincular 
a una columna del documento importado.

▶  Los elementos y las columnas vinculadas mostrarán un punto con idénticos número y color:

Para indicar una o varias columnas de referencia:

 1. Haga clic en Avanzado (Advanced).

 2. Si aún no está marcada, marque la casilla situada al lado de la columna del 
documento importado.

 3. Haga clic en el icono de llave situado al lado de la columna del documento 
importado: 

▶  Las columnas de referencia quedarán indicadas mediante un icono de llave azul:

 4. Haga clic en Aceptar (OK).

 3. Cuando haya terminado de vincular los elementos y las columnas, haga clic en Avanzar > (Next 
>) y, a continuación, Terminar (Finish).

   

Editar los datos

Modificación de datos de texto en la tabla de datos

   1. Haga doble clic en la celda de la tabla de datos (en la fila de la tarjeta correspondiente) donde se 
encuentra el valor que desea cambiar.

 2. Introduzca el valor deseado en la celda de la tabla de datos.

 3. Pulse la tecla Intro.

▶  El valor de la tarjeta correspondiente a la fila se modificará también.
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Cambiar una imagen en la tabla de datos

   1. Haga doble clic en la celda de la tabla de datos (en la fila de la tarjeta correspondiente) donde se 
encuentra la imagen que desea cambiar.

▶  Se abre el explorador del ordenador.

 2. Seleccione un archivo de imagen.

▶  La imagen de la tarjeta correspondiente a la fila se modificará también.

 

Vincular un elemento a otra columna

  Cuando se añade un nuevo elemento a la tarjeta, se crea automáticamente la columna correspondiente 
en la tabla de datos. El elemento puede vincularse a otra columna de la tabla de datos (si ya ha 
importado una base de datos que contenga la información del elemento).

 1. Haga clic en el elemento de la tarjeta.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Avanzado (Advanced)  > Base de datos (Database), en la lista desplegable, seleccione la 
columna que desea vincular.

▶  El elemento se vincula ahora a una nueva columna y se actualizan los datos mostrados en la 
tarjeta.

Transformar un elemento en fijo

  Los elementos que son fijos son idénticos en todas las tarjetas del documento y aparecerán en todas 
ellas.

 1. Haga clic con el botón derecho en el elemento y seleccione Transformar en 
texto/imagen/código de barras variable.

▶  Se abre una ventana para confirmar la transformación.

 2. Haga clic en Aceptar (OK) para confirmar.

▶  La columna vinculada se eliminará de la tabla de datos.

Los datos de esta columna no se podrán recuperar.

Cambiar el nombre de una columna

   1. Haga clic derecho en el encabezado de la columna y luego haga clic en Cambiar nombre de 
columna (Rename column).

 2. Introduzca el nuevo nombre de la columna directamente en su encabezado.

 3. Pulse la tecla Intro.
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Buscar/ordenar los datos

Buscar datos

   1. Introduzca la información que busca en la barra de búsqueda (texto/datos del código de barras):

 2. Seleccione una columna de la lista desplegable situada a la derecha de la barra de búsqueda para 
afinar la búsqueda:

  

▶  Solo se mostrarán las filas que coincidan exactamente con los criterios de búsqueda 
especificados.

 3. Elimine todos los caracteres del campo de búsqueda para volver a visualizar todas las filas.

Reorganizar columnas

  Haga clic derecho en un encabezado de columna y luego haga clic en Mover a la izquierda (Move 
left) o Mover a la derecha (Move right).

Bloquear/ocultar los datos

Bloquear/desbloquear una columna

 1. Haga clic derecho en el encabezado de la columna y luego haga clic en Opciones avanzadas 
(Advanced options).

 2. Marcar/desmarcar Proteger columna (Protect column).

▶  Los datos de una columna bloqueada no se pueden editar, copiar ni eliminar.

Todo elemento vinculado a una columna bloqueada se puede personalizar, cambiar 
de tamaño y de posición.

Ocultar una columna

  Haga clic derecho en el encabezado de la columna y luego haga clic en Ocultar (Hide).

▶  Los elementos correspondientes de la tarjeta también se ocultarán.
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Mostrar una columna

   1. Haga clic derecho en cualquiera de los encabezados de columna y luego haga clic en Mostrar 
(Unhide).

 2. Marque la casilla de la columna que desea mostrar.

▶  El elemento correspondiente de las tarjetas también se mostrará.

Copiar/exportar datos

Copiar y pegar una fila

   1. Haga clic derecho en cualquiera de las celdas de la fila con los datos que desea copiar y luego 
haga clic en Copiar línea (Copy line).

 2. Haga clic derecho en cualquiera de las celdas de la fila con los datos que desea reemplazar y 
luego haga clic en Pegar línea (Paste line).

▶  Los datos que había en esa fila serán reemplazados.

Duplicar una fila

  Haga clic derecho en cualquiera de las celdas de la fila con los datos que desea duplicar y luego haga 
clic en Duplicar línea (Duplicate row) 

▶  Se añadirá a la tabla de datos una fila que contiene los mismos datos.

Más tarde, podrá editar esta fila sin que se actualice la otra fila.

Propagar un valor/imagen a toda la columna

   1. Haga clic derecho en la celda de la tabla de datos que contiene el valor/imagen que desea 
propagar.

 2. Seleccione Aplicar esta imagen a todas las filas (Apply image to all rows) / Aplicar este 
valor a todas las filas (Apply value to all rows).

▶  El valor/imagen se propagará a todas las celdas de la misma columna.

Más tarde podrá modificar todas las celdas de esta columna sin que las otras celdas se 
actualicen.

Exportar datos

 1. Abra el documento que contiene los datos que desea exportar.

 2. Haga clic en Archivo (File) > Exportar los datos (Export data).

 3. Haga clic en el icono del directorio:
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 4. Seleccione la ubicación donde se almacenarán los datos.

 5. Desmarque las casillas de las columnas que no desee exportar.

 6. Haga clic en Exportar (Export).

▶  En la ubicación seleccionada se guarda una carpeta comprimida que contiene un archivo 
Excel con los datos exportados.

Eliminar datos

Eliminar filas

   1. Seleccione las filas que desea eliminar.  

   l Para seleccionar una o más filas para su 
eliminación, marque la(s) casilla(s) de la(s) fila
(s).

 

   l Para seleccionar un rango de filas que desea 
eliminar, marque la casilla de un extremo del 
rango de filas, mantenga pulsada la tecla 
Mayús y marque la casilla del otro extremo 
del rango.

 

   l Para seleccionar todas las líneas que desea 
eliminar, marque la casilla situada encima de 
la casilla de la primera fila.

 

   2. Haga clic en el icono de la papelera.

  

No es posible recuperar los datos 
eliminados.

 

Eliminar una columna

  Haga clic derecho en el encabezado de la columna y luego haga clic en Suprimir columna (Delete 
column).
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No es posible recuperar los datos eliminados.

Todo elemento vinculado con la tarjeta también se eliminará.



Impresión Interfaz de impresión

49

Impresión
Interfaz de impresión

  La interfaz de impresión se muestra después de haber seleccionado las tarjetas que se van a imprimir y 
de hacer clic en el icono de impresora que hay en el área de diseño de tarjetas. Permite configurar los 
ajustes de impresión antes de imprimir.

  

  Actualizar la lista de impresoras disponibles
  

  Formato de tarjeta Tamaño de la tarjeta (Card size):

Tarjeta larga 120 x 50 mm (Long card 120 x 50 mm)

Tarjeta larga 150 x 50 mm (Long card 150 x 50 mm)

  Tarjetas del tamaño de tarjeta de crédito común CR80

  Cumplimiento de la norme ISO que especifica las 
características físicas de las tarjetas

CR80 (ISO7810)

  Para imprimir el anverso
  

Para imprimir el reverso

  

  Para imprimir por ambos lados

  

  Afinación (antialiasing) Avanzado (Advanced) > Representación 
(Rendering) > Suavizado (Anti-aliasing)

  Resolución de impresión Avanzado (Advanced) > Configuración de la 
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impresora (Printer settings) > Resolución (DPI) 
(Resolution (DPI))

  Orientación del contenido del reverso con respecto 
al del anverso

Avanzado (Advanced) > Configuración de la 
impresora (Printer settings) > Girar el reverso 
180 grados (Rotate Back 180 degrees)

  Para iniciar la impresión

  

Imprimir tarjetas

Comprobar la impresora (Windows)

  AbraBadgy Print Center (por ejemplo, desde el menú Inicio de Windows o un icono del escritorio).

El estado de la impresora debería ser Lista (Ready):

 

Si el estado de la impresora no es "Lista (Ready)", consulte los recursos de asistencia (incluida la guía de 
usuario) para las impresoras Badgy.

Seleccione las tarjetas que desea imprimir

  Para seleccionar una o más filas para su eliminación, 
marque la(s) casilla(s) de la(s) fila(s).

 

  Para seleccionar un rango de filas que desea 
imprimir, marque la casilla de un extremo del rango 
de filas, mantenga pulsada la tecla Mayús y marque 
la casilla del otro extremo del rango.

  

  Para seleccionar todas filas que desea imprimir, 
marque la casilla situada encima de la casilla de la 
primera fila.

 

  

https://myplace.evolis.com/s/product/badgy-200/01t5p00000CXScjAAH?language=es&tabset-4085f=1
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Configurar la no impresión de un elemento

   1. Haga clic en el elemento de la tarjeta.

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Avanzado (Advanced)    > Elemento (Item), deje sin marcar Imprimir (Print).

Configurar la no impresión del fondo de la tarjeta

   1. Haga clic en Editar (Edit) > Editar el fondo (Edit card background).

▶  El panel Propiedades se abrirá a la derecha del área de diseño de tarjetas.

 2. En Avanzado (Advanced) > Fondo (Background), marque No imprimir el fondo (Don't Print 
Background).

Configurar/iniciar la impresión

   1. Haga clic en el icono de impresora del área de diseño de tarjetas:

 

▶  Se abrirá la interfaz de impresión:

 

 2. Configure los distintos parámetros de impresión disponibles

 3. Haga clic en el icono Imprimir (Print) cuando haya configurado los parámetros de impresión.

Marque la casillaImpresión del reverso gracias al asistente de impresión a doble cara (Print the 
back side using the duplex printing wizard)
▶  Se abrirá un asistente: 
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Siga las instrucciones que irán apareciendo en pantalla.
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Referencias y ayuda
  Conceptos de impresión
  suavizado

Técnica destinada a obtener un acabado más suave de los píxeles, 
atenuando el aspecto irregular de los bordes. La configuración de 
impresión le permite indicar con precisión si desea aplicar el suavizado 
al texto, las imágenes o a ambos.

   

  brillo

La medida en la que una imagen parece irradiar luz. Una luminosidad 
más alta lleva la gama de tonos hacia el blanco.

débil alta

  contraste

La diferencia entre las partes sombreadas y claras de una imagen. Un 
contraste elevado amplía la gama de tonos, acentuando las diferencias 
entre las partes sombreadas y claras de una imagen. En el plano físico, 
cuando el contraste es más elevado, el cabezal de impresión se calienta 
a una temperatura más alta y se aplica más colorante a la tarjeta.

débil alta

  escalas de grises

Matices que van desde el negro absoluto hasta el blanco absoluto. En 
una imagen monocroma, en cambio, faltan estos matices entre el 
negro absoluto y el blanco absoluto.

 

  monocroma

Este término significa «un color», pero los retos prácticos varían según 
el ámbito de aplicación.

En fotografía y grafismo, una imagen monocroma está compuesta 
exclusivamente de negro absoluto y blanco absoluto, sin matices de 
gris u otros colores entre esos extremos.

En impresión, una cinta monocroma tiene un único color 
(normalmente el negro o el blanco) y, en consecuencia, o aplica el 
color de su colorante o no aplica ningún colorante en absoluto.

Cuando se imprime una imagen con una cinta monocroma, es 
necesario:

 l Seleccionar una imagen que tenga zonas claras y sombreadas 
bien definidas. No debe tener matices de gris ni de otros colores.

 l Convertir imágenes a formato monocromo. Badge Studio ofrece 
esta opción de formato para una imagen añadida a la tarjeta o 
para el fondo de la tarjeta.
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  negativo

Imagen en la que los colores sombreados y claros se han invertido. En 
una imagen monocroma, el negro absoluto y el blanco absoluto se 
invierten. Esta opción es especialmente útil para imprimir con una 
cinta blanca en tarjetas negras.

 

  resolución de impresión

La resolución de impresión representa la densidad de los puntos de 
colorante aplicados por el cabezal de impresión a la tarjeta. Se mide en 
puntos por pulgada (ppp). Aumentar la resolución de impresión puede 
mejorar la calidad de las imágenes que tienen detalles muy precisos, 
pero reduce la velocidad de impresión.

Las posibles resoluciones de impresión dependen del modelo de 
impresora y del tipo de cinta (monocroma o color):

Impresora color/monocroma resolución (ppp)

BADGY 100 monocroma 300

BADGY 200 monocroma 300

   

  saturación

Medida en la que los colores de una imagen parecen reales.

débil alta

  Tipos de código de barras
  Código de barras 1D

Código de barras clásico que codifica los datos mediante barras 
verticales.

 

  Código de barras 2D

Código de barras que codifica los datos mediante cuadraditos 
pequeños.

Los códigos de barras 2D son capaces de codificar más datos que los 
códigos de barras 1D. Por tanto, pueden utilizarse para direcciones 
web o información detallada sobre lotes.

 

  Código QR

Marca registrada. Es una norma de codificación para los códigos de 
barras 2D.

   

  Formatos de tarjeta
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  tarjeta de crédito

Tarjetas del tamaño de una tarjeta de crédito común (86 x 54 mm) que 
se suministran con las soluciones.

   

  Ayuda

Descargar PDF

Puede descargar una versión de esta guía en formato PDF desde www.evolis.com  > Sección de 
asistencia > Página del producto.

También se puede acceder al PDF con el botón Ayuda (Help) del software.

Vídeo explicativo

El vídeo explicativo presenta las funciones más importantes que ofrece Badge Studio. El vídeo se 
ejecutará al iniciar el software por primera vez.

El vídeo explicativo también se puede iniciar en cualquier momento desde la interfaz de inicio, 
haciendo clic en Ayuda (Help) > Iniciar el vídeo explicativo (Launch guided tour video).

Tutoriales

Visualice los videotutoriales en el canal de YouTube de Badgy.

Base de conocimientos

Buscar en la Base de conocimientos en línea.

Asistencia técnica

 l Póngase en contacto con el servicio de asistencia de su distribuidor.
 l Rellene el formulario en línea.

https://es.evolis.com/
https://www.youtube.com/@badgycardprinter/featured
https://myplace.evolis.com/s/topic/0TO5p000001UPchGAG/evolis-badge-studio?language=es
https://myplace.evolis.com/s/contactsupport?language=es
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C

columna
Una columna agrupa datos de un determinado tipo en la tabla de datos. Por ejemplo, una 
columna llamada «Origen» con un nombre de lugar para cada fila (representando una tarjeta). 
Cuando una columna está vinculada a un elemento variable de la tarjeta, dicha columna sirve 
como fuente de datos.

columna de referencia
Una columna que sirve para identificar y gestionar las filas duplicadas. La columna de referencia 
puede ser definida automáticamente por el software o por el usuario. Puede ser, o no, una 
columna vinculada a un elemento de la tarjeta. Es posible definir más de una columna de 
referencia para los mismos datos si una sola columna de referencia no es suficiente para 
identificar las filas de manera exclusiva.

D

datos
El texto, las imágenes, los datos codificados mediante códigos de barras y la información sobre 
alérgenos incluidos en la tabla de datos.

documento
Un archivo de Badge Studio (con la extensión .bs) que contiene una tabla de datos y un modelo 
de tarjeta para una serie de tarjetas.

E

elemento
Elementos que pueden añadirse al modelo de tarjeta y personalizarse/formatearse. Un 
elemento variable está vinculado a una columna de la tabla de datos.

F

fijo
los elementos del modelo de tarjeta que son fijos (en contraposición a los variables) son 
idénticos en todas las tarjetas de su documento y aparecerán en cada una de ellas. Por ejemplo, 
puede ser interesante añadir una imagen fija de su logotipo y que aparezca en todas las 
tarjetas.

fila
Cada fila de la tabla de datos incluye los datos para una sola tarjeta. Cada fila nueva que se 
añada a la tabla de datos añadirá una tarjeta correspondiente a la serie de tarjetas.
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M

Modelo
Los modelos de tarjetas suministradas por Evolis están disponibles en la biblioteca de tarjetas. 
Los modelos ya están provistos de un fondo y de varios objetos que el usuario puede editar y 
personalizar.

T

tabla de datos
La tabla de datos contiene y gestiona los datos que pueden representarse en las tarjetas del 
documento.  Está organizada en columnas y filas.

V

valor
Un valor corresponde a los datos específicos de una sola celda de la tabla de datos.

variable
Los elementos del modelo de tarjeta que son variables (en contraposición a los fijos) le 
permiten variarlos de una tarjeta a otra, o incluso omitirlos en las tarjetas que quiera. Por 
ejemplo, una imagen variable puede representar los alérgenos específicos que contiene un 
producto.
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